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Preparing Essays for English Classes
(Version for Microsoft Word 2004 for Mac)
This document is both an explanation and a guide for preparing English papers. The
faculty strongly recommend that all essays be prepared on Macintosh computers using
Microsoft Word. You should follow these directions when you prepare your essays, and
your essays should look like this document, except that this is single spaced to save
paper. Your name, class and section, and the date should appear at the upper right of the
first page. The title should be centered a few inches down from the top. Choose with care
a title that is well-phrased and informative: "Emily Dickinson's Poems about God";
"Buzz, Buzz: Dickinson's Inbred Insects." Your text should be double spaced except for
extended quotations and a list of works consulted which are explained later.
Your first paragraph should establish a topic (even if one is assigned) and present a
thesis. Introduce the topic quickly and closely. If you are to write on a poem by Keats,
make that clear immediately. Don't sneak up on it after noting that poems have been
written throughout history. A thesis is an idea about the topic; with luck the idea will be
interesting and powerful. If your topic were the imagery of Keats's "To Autumn," you
might consider these two theses:
a. The poem presents many different kinds of images of the harvest season.
b. The poem's imagery divides the season into three distinct stages, early, middle
and late, whose movement underscores the beauty as it reinforces the sad
inevitability of the way all life moves towards death.
The first is a trivial commonplace. The second constitutes the real idea of someone who
understands something about the poem. The difference between them is real, is typical of
college essays, and is often indicated by professors with letters C and A. Your first
paragraph should address an intelligent audience familiar with your topic. Your first
paragraph is crucial, and should be written or rewritten last.
Paragraphs, like essays, should have topic sentences. The body of the paragraph
should deal with the topic introduced in the first sentence. Each sentence should be tied to
the next with logic and language. Each sentence, in other words, should reach back to the
one preceding and reach forward to the one that follows. You should be able to scramble
the sentences of a paragraph and reassemble them inevitably. Scramble one of yours and
see if a friend can put it back together. See if you can.
The word processor seems to make it easier to write a correct paragraph, but harder to
keep clear track of each paragraph's place in the whole. If you were to list the topics of
each of your paragraphs, the list should reveal obvious and compelling principles of
organization that lead through your topic to explain and prove your thesis. A sure way to
improve your written work is this. Print out a draft and lay out the pages. In the margin
next to each paragraph write a key word or two expressing the main topic. Then look
over the sequence and, if any paragraph fails to seem obviously in the right place, cross it
out or draw an arrow where it should be moved. Then consider whether an added or
altered phrase at the beginning or end of each paragraph would make real connections
clearer, or give the appearance of connection where there is none. (If you are using

Microsoft Word, you can get an even quicker [and sometimes terrifying] view of your
essay's structure by choosing the "outline" command in the view menu and clicking on
the icon that reduces each paragraph to the first line. Look on your work, you mighty, and
despair!)
There is no better guide to style than the advice to be found in a little book, The
Elements of Style by William Strunk and E. B. White. You should own this book and read
it until its contents are part of your personality. In general, aim for a clear and unaffected
style in middle diction. Avoid repeated noun + preposition phrases when verbs are
available for the purpose: x is the representation of y, x is certain evidence of y, x is a
description of y are stronger and simpler in this form: x represents, proves, or describes y.
Avoid heavy use of the verb to be that comes with overusing noun phrases and overusing
the passive voice. Avoid forms like There is a movement that influences and It is cubism
that is influential; instead say Cubism influences. Don't start sentences with
demonstrative pronouns (notably this). Avoid empty assertive qualifiers like pretty, very,
truly, virtually, incredible, and awesome. Don't overuse the vague words aspect, facet, or
element, the pop-psy words lifestyle, mindset, wellness, or relationship. Avoid the adverb
hopefully.
Quotations and other specific references to the text form the evidentiary backbone of
literary argument. Use brief, pithy, pertinent quotations to substantiate or demonstrate
your points. Don't use quotations when summary would serve more quickly and as well.
Quotations are not necessary to establish facts of person, costume, setting, statement, and
incident, but rather to substantiate judgments about language, character, motivation,
values, and ideas. Judgments about writers should be based on your observation of their
own work, not on secondary opinions drawn from lectures or textbooks. A long
quotation should be justified by extensive and careful analysis of the quoted
passage. And always double check your quotations for accuracy. Far too many student
quotations contain errors.
According to the College of Arts and Sciences catalogue,
plagiarism is a form of cheating because the plagiarist copies or imitates the
language and thoughts of others and passes the result off as an original work.
Plagiarism includes failing to identify a direct quotation by the use of quotation
marks or another accepted convention which delimits and identifies the quotation
clearly, paraphrasing the work of another without an acknowledgment of the
source, or using the ideas of another, even though expressed in different words,
without giving proper credit.
(346)
Avoiding plagiarism is imperative and simple. Follow these requirements:
1. At the end of your essay, include a list of every secondary work you consult in its
preparation.
2. Before every quotation, paraphrase, or allusion involving one of these consulted
works, introduce the name of its author.
3. At the end of every quotation, paraphrase, or allusion to one of these consulted
works indicate, in parentheses, the page numbers where the pertinent words or
ideas can be found.

This parenthetical system of documentation has been approved by the department for
all students in English classes. It is described much more completely in the MLA
Handbook, and, though this brief description will serve most purposes, that book is
available at the library (on reserve) and bookstore and should be consulted by authors of
more complex research papers.
Quotations should be surrounded by quotation marks or indented, and the words in
quotation marks or indented should be exactly the words that appear in the text you
indicate with two exceptions that should be used sparingly. Explanatory or clarifying
information may be added in square brackets, and omissions may be replaced by marks
of ellipsis—three spaced dots. Here's an ellipsis in square brackets: [ . . . ]. A period is
required in addition if the ellipsis occurs between one sentence and part or all of another.
Three or more lines of poetry or more than 60 words of prose should be indented (in
which case use quotation marks only as the author does). Introduce quotations with a
clause or phrase that fits the excerpt grammatically; be sure the thought is complete.
Punctuation of and around quotations is complicated but exact. A colon follows an
independent introductory clause (Here is Searle’s thesis: . . . ). A fragment that fits your
sentence seamlessly needs no preceding punctuation. Otherwise, a comma usually
precedes (As Northrop Frye argues cogently, . . . ). When quoting poetry, be sure to
follow the poet's conventions of initial capitalization and indentation, and to indicate the
line endings with a slash mark (virgule) or, in indented quotations, by typing your lines
exactly like the original. At the end of an excerpt, period and comma precede quotation
marks, semi-colon and colon follow. Question mark and exclamation point depend on the
sense (Did he say "Go to hell!"?). Exception: if a parenthetical citation follows a
quotation, the punctuation follows the parenthesis (see example 1). Exception to the
exception: punctuation precedes parenthetical citation after indented quotations (see
example 2).
Here are some examples:
1. Romeo's "mind misgives / Some consequence yet hanging in the stars"(1.4.1067).
2. As he is entering the great hall, Romeo delivers his most important speech about
fate:
. . . my mind misgives
Some consequence yet hanging in the stars
Shall bitterly begin his fearful date
With this night's revels and expire the term
Of a despisèd life, closed in my breast,
By some vile forfeit of untimely death.
(1.4.106-111)
3. According to Hugh Kenner, the detail of the lady in the white gown "simply
records the way Vivien Eliot looked when she was hospitalized" (33).
4. In an early essay, E. E. Stoll contends that Shylock receives "the heaviest
penalty to be found in all the pound of flesh stories" (121-22).
5. Kenneth Myrick provides some indispensable pages on Shylock's relationship to
Judaism (lxxiv-lxxvi).
6. Our editor's lengthy explanation (DiYanni 9-12) is ultimately unsatisfactory.

7. If you follow the MLA web site to MLA Style” and click on the “MLA
Handbook” link, you will find a link to frequently asked questions and answers to
most questions about how to cite electronic sources (www.mla.org).
Citations appear in parentheses and contain no more information than is necessary. If
the author is mentioned in the text, only page numbers appear in the citation. Otherwise,
last name and page number appear without intervening comma or p./pp. abbreviation. For
examples, see the citations above, especially 3 through 6. All of these citations mean that
the words or ideas in question can be found on the cited pages of books identified fully,
by author's name, at the end of the essay.
You must proofread your essays carefully; enlist the help of a classmate or friend if
you are a poor editor. Number your pages with your name on each page. Provide a List
of Works Consulted in the same form as the list at the end of this document. If you are
using the Macintosh and Microsoft Word for Office ‘98, specific instructions for these
and other routine formatting operations are included in the following appendix.
Appendix I. Formatting an Essay with Word 2004 for Mac
When you enter the text of your essay, be sure that you type the return key only at the
end of a paragraph (or line of poetry). Typing returns at the end of lines of prose makes
future editing and formatting tremendously time-consuming. At the end of the first
paragraph, choose the "Save" command from the File menu. Give your document a
name in this form: Your last name, your subject. For example: "Clarkson, T.S Eliot" or
"Richardson-Hamlet essay." If you wish to take out insurance, choose Preferences form
the Word menu, choose Save, and check "Always make backup copy." Before you click
to save a file for the first time, notice the disk and folder where you are directing your
document to be saved. If you want it saved elsewhere, make the change now. Be
especially careful that you don't save your essay to a friend's disk or a lab disk drive that
will be locked, erased, or out of town when you return. Save frequently as you proceed. If
you are working during an electrical storm, save and pray frequently.
To indent a quotation, first type it normally with no returns or, in the case of poetry,
with a return at the end of each line. Then select the quotation and move the quotation by
dragging to the right the square below the lower of the two triangles that appear at the left
of the ruler scale.
Run spelling check (tools menu) before printing your essay. (You may do just as well
with the feature that marks questionable spelling with red underline and questionable
grammar with green underline.) Professors are often very hostile to errors SpellCheck
should have caught. Then proofread. Ewe cant ketch aviary arrow bye dewing
SpellCheck a loan. In the preceding sentence, only the word "SpellCheck" would be
presented for correction. Be particularly careful with proper nouns. The checking utility
will present "Shakspeare" and Emily "Dickenson" for your decision. Both names are
misspelled.
Your last name and the page number should appear in the upper right corner of every
page except the first. To effect this result choose "Header and Footer" in the View menu.
Use the tab key to get where you want to go in the header and footer spaces. The # icon

will put in an automatic page number. The “1” icon will make the first page header and
footer different from the rest of the pages. With a little ingenuity you could put your
name and other information in the first page header and number the first page by
centering the number in the footer. You could then put your last name and page number
in an appropriate place for the following pages.
If you have consulted secondary sources, proceed as follows. At the end of your last
paragraph type the return key once, then hold down the shift key and press the key
labeled “enter.” That sequence will insert a page break, and you can then enter the title
"List of Works Consulted." Then enter each work you have consulted as a paragraph
with a period following each of the following entries (You will find examples at the end
of this document; see MLA Handbook for more complicated situations.):
1. Name (last first) of the person who wrote what you quote. If you cite an essay
from a collection you should name the author of the essay, not the editor of the
collection.
2. Title of the work, in quotation marks if a work in a collection or anthology,
underlined or in italics if a complete book.
3. If 2 was a work in a collection, this entry should provide the collection title.
4. This sentence might provide the name of a collection editor or a translator
(following abbreviations "Ed." or "Trans.").
5. Place of publication: publisher, date of publication.
Center the title (List of Works Consulted) using the formatting palette, and then
format your list in five steps:
1. select every item in your list from first to last
2. choose "Sort" in the Table menu to alphabetize
3. while all items are still selected, point to the lower triangle just above the square
at theleft of the ruler and drag it one half inch to the right. (You can also just type
command + t.)
4. while all items are still selected, click on the single space icon in the formatting
palette.
5. while all items are still selected, use “Paragraph Spacing” in the formatting
palette to space between each entry.
Here are three last steps. First, set your essay in a suitable font. To set the font select
the whole document (choose Select All from the Edit menu) and then make your choice
from the Font menu or formatting palette. I suggest you use Palatino or Bookman 12
point. To make the text appear on fewer pages, use Times (as I have done here). To make
it appear on more pages, use New York. In any event, use a serif font, not a sans-serif
font like Helvetica.
This sentence is set in Helvetica—a sans-serif font.
Next choose Print Preview from the File menu and scroll through your essay. Check the
header, the location and spacing of quotations, and so on. If you have changed font you
may wish to Adjust font choices in headers, footers, and footnotes. If you have not
followed instructions about indentation, you will have to redo your quotations. Finally,
print your essay on a laser printer.
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